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Chapter 1

Introduction

1.1 General Information

DOASIS is an all–round tool with which work with spectral data can be done. From ac-
quiring to evaluation, everything can be done using the easy–to–use graphical user interface
(GUI), which features:

• Tabbed Multiple Document Interface (MDI)

• Free floating docking windows for various kinds of toolboxes.

• Self–adapting menu structure (Office like menus)

• Shortcuts to various operations and hot–keys to quickly start user–defined scripts.

• Quick access to different kinds of operations using a floating toolbar.

• Support for Windows XP style settings.

• Full–featured support for modern multi user systems. Each user on a system can have
his own settings that even propagate through domains automatically.

• Save the current programm state into a check point and restore it later to switch back
to the original spectrum data.

Of course the functionality of the user interface can provide only basic operations. For more
complex tasks the user must be able to define measurement or evaluation set–ups that fit
best for his needs. Therefore DOASIS offers a scripting language called Jscript, which gives
the user full control over the behaviour of the application and allows a fully automated
usage. The script interface currently supports:

• JScript.NET language, which is based on JavaScript, an easy to learn programming
language.

• Full access to all core functions of DOASIS including support of:

– Spectra management: Create your own spectrum objects and manage them in
collections.

– Device control: Use several kinds of spectrographs, stepper motors, etc.

– Mathematical support for spectral data.

– I/O support to load and save a spectrum in various kinds of file formats.

– Unified access to the user interface to communicate with the user from a scrip.
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• Full asynchronous event handling model, so the user interface automatically recognizes
changes made from a script to spectrum objects.

• Run a script in console mode without any graphical user interface. This feature can
be used to run scripts on systems with little system resources where the GUI is ”too
heavy”.

• Full debugging support of scripts using one of the .NET debuggers available.

• Script compiler instead of an interpreter to let scripts run with maximum performance.

All these features make DOASIS one of the most flexible applications suitable for anyone
who needs to work with spectral data.

This tutorial of DOASIS introduces frequently used tasks in DOAS work. The Chapter
2 gives an overview of the graphical user interface and of some basic skills in handling
spectra. Chapter 3 provides a complete description of all DOASIS menu points. In Chapter
4 the console windows will be explained, which also include some fitting examples. All
properties and statistic items will be covered in Chapter 5. Since DOASIS can control
different instruments, which use different methods to acquire spectra, Chapter 6 informs
about the hardware that can be used and introduces some commonly used instruments
(Acton spectrograph, HMT DOAS Controller and Ocean Optics).
For this tutorial it is assumed that DOASIS users are familiar with the basics of the DOAS
technique.

1.2 Installing DOASIS

Minimum System Requirements:

• 200 MHz Pentium or compatible processor

• 64 MB RAM

• 60 - 100 MB hard disk space

• Microsoft Windows 98 or better (maybe later support for Linux)

• SVGA with a resolution of 800x600 at 16 colours

• Microsoft .NET Framework v1.1 or later (if this is not on your computer a link will
automatically be given while installing DOASIS)

Recommended System Requirements:

• 500 MHz Pentium II or compatible processor

• 256 MB RAM

• 100 MB hard disk space

• Windows 2000 or better

• XSVGA with a resolution of 1280x1024 at 24 bit colour depth

• Microsoft .NET Framework SDK v1.1 or later (if this is not on your computer a link
will automatically be given while installing DOASIS)

Installation package (you can choose which components shall be installed; all will be installed
by default):
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• Ocean Optics Library

• Solar Zenith Angle (SZA) calculation support

• Reference spectra

Since this is not yet the final version and minor changes might still be made, further updates
and changes can be downloaded at:
http://www.iup.uni-heidelberg.de/institut/forschung/groups/atmosphere/software

1.3 Who can use DOASIS?

Commercial usage is not allowed without an explicit license grant from the author or the
Institute of Environmental Physics. DOASIS is a non-commercial product that may be used
by anyone else, but for scientific purpose only.
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Chapter 2

First Steps

In this chapter DOASIS is presented to a novice user. The focus will be on basic skills of
handling spectra that are already stored on disk, and to make best use of the graphical
user interface. All tasks will be performed on exemplary spectra that will be provided by
DOASIS so at this point DOAS hardware is not needed.

2.1 Starting DOASIS

To begin the tutorial, start DOASIS using the Windows start-menu. The DOASIS main
window opens. On top of the DOASIS screen are the usual elements of a Windows-style
program, i.e. a menu bar and tool buttons for fast access to frequently used menu functions.
Use file→open or the tool-button to locate the demo Fraunhofer spectrum ’First Example.spe’
in the spectra folder within the DOASIS program folder. After opening it the spectrum is
displayed on the spectrum sheet.
Now the key elements of the DOASIS screen, as shown below, are covered in detail.

2.2 Elements of the main screen

• Spectrum sheets: Spectrum sheets are used to display a graph of the spectrum data.
The spectrum is plotted as a line graph in which the counts per detector channel
are plotted against the channel (or wavelength) number. The count axis is scaled
automatically to fit the plot area. file→open will display a new spectrum sheet, which
is labeled with the spectrum’s name or file name (for more on what exactly is meant
by file and spectrum name see 3.1. The top spectrum sheet will be called the active
spectrum sheet to which any kind of action concerning the alteration of spectra will
apply exclusively.

• Spec bar : The Spec bar is an autonomous window, which holds thumbnail pictograms
of all spectra that are currently open in a DOASIS session. Click on a thumbnail to
display the selected spectrum in the active spectrum sheet. This can also be done by
clicking on the spectrum sheet’s name.

• Information window : The Information window consists of three sheets: statistics,
properties and fit results. In the statistics sheet e.g. minimum, maximum and average
count of the active spectrum are displayed. The properties sheet contains a lot of
information about the spectra such as file information (file name etc.), markers &
display and scan parameters, whereas the fit results sheet shows information of realized
fits. For a more detailed description of the information window see 5.

• Console window : the console window consists of several sheets as well: the console
sheet displays the running status of the program (e.g. running scripts etc.), the dif-
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Figure 2.1: The main application window of the graphical user interface part DoasUI.

ferent script sheets are used for creating and editing automation scripts (automatic
control of the program e.g. doing automatic measurements and data evaluation) and
the fitting sheet for creating a fit scenario for spectra analyse.

2.3 Navigation in the active spectrum sheet

• Mouse-Zoom: Using the mouse is the easiest way to zoom. Click in the active spectrum
sheet at the position of the new left margin. While holding down the left mouse key,
drag the mouse towards the new right margin. A light grey rectangle opens to indicate
the zoom area. Due to the auto-scaling of the vertical axis the height of the zoomed
rectangle is irrelevant. The new limits become valid as soon as you release the left
mouse key. This can be repeated as often as needed. To reverse the zoom by just
one step drag the mouse from the lower right to the upper left while holding down
the left mouse key. A pink rectangle opens, yet size and place don’t matter, because
it will zoom out according to the zoom in done before. To return to the un-zoomed
state right-click anywhere in the graph. Any further right-click will toggle between
the zoomed and un-zoomed state.

• Numeric entry : Select the properties sheet. There is a ”ChartYAxis” entry among
the subtitle marker & display. It is set on ”auto” by default. When clicking on ”auto”
it can be changed to ”fixed”. If a numeric entry for the maximum and minimum
values of the y–axis is favoured this can be implemented through an entry in the
”ChartYAxisMax” and ”ChartYAxisMin” boxes. In order to change the limits of the
x–axis numeric values can be entered under ”MaxChannel” and ”MinChannel”.
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2.4 Limits: Setting markers and selecting ranges

During the evaluation of a DOAS spectrum it is frequently desirable to limit an operation
to a range within the spectrum. For this purpose DOASIS provides four sets of markers: a
fit–, math–, optical density– and general–purpose marker. To set and move markers several
techniques can be used:
The markers can be activated under view→markers→whichever marker you want. When
activated a coloured array will appear. Now you can either use the mouse to move, minimize
or enlarge the array or you can use numerical entries, which you can set in the properties
window under marker & display (for further information see 3.8). Another possibility, in
case you don’t like the coloured arrays, is to change these arrays to coloured lines (this might
be especially useful if you want to overlay several markers). To do so choose view→show
marker range.

Figure 2.2: Example of the different kinds of markers.

2.5 Managing a collection of spectra

So far the focus has been on the active spectrum sheet, using just one spectrum. In DOAS
work, usually a substantial number of spectra are involved, e.g. descendants of the raw
spectrum as created by math operations, lamp, background and several reference spectra.
The central tool to manage a collection of spectra is the Spec bar. To get used to working
with the Spec bar follow these steps:

• Open the demo spectrum from the spectra folder in the DOASIS program folder,
’First Example.spe’, if not already done so at the start of this tutorial, using the
file→open menu.

• Open the spectra:
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– ’BackgroundSpec.spe’

– ’DarkCurrentSpec.spe’

– ’HGRefSpec.spe’

– ’IO–Reference.sp2’

– ’Lamp–Reference.sp2’

– ’MeasSpec.sp2’

– ’NO2–Reference.sp2’

– ’OffsetSpec.spe’

– ’RohSpec.spe’

The active spectrum sheet displays the most recently loaded spectrum. In the Spec bar ten
thumbnail pictograms of the loaded spectra are shown.
Each new spectrum is displayed on a new spectrum sheet. The spectrum sheets are sorted
like a register. By clicking on the nametag, a spectrum will be displayed in the active
spectrum sheet. A spectrum sheet can be closed by clicking on the x-button in the right top
corner of the active spectrum sheet, yet this spectrum is still part of the current DOASIS
session, because it is still displayed in the Spec bar.
The Spec bar is the main repository of all spectra that are or have been active during a
DOASIS session. The pictograms represent the data of the spectra as stored in the PC
memory. Whenever a new spectrum is created, loaded or duplicated, a new entry in the
Spec bar is created.
A spectrum from the Spec bar can be displayed on a spectrum sheet at any time by clicking
on the pictogram or on the spectrum’s name.
To completely remove a spectrum from the DOASIS session, right-click on the pictogram or
the name and choose ”close”. Note that by removing the spec bar icon, the entire spectrum
sheet will be removed as well.

2.6 Oops: The undo–redo function

The interactive evaluation of spectra with the DOAS–method have elements of trial–and–
error. You may want to experiment with various degrees of filtering, readjust windows for
math operations, or compare the outcome of a previous operation with a current one. For
this purpose, DOASIS offers an extensive, multi–level undo–redo concept.
Each operation, which modifies a spectrum, is preceded by an invisible backup of the initial
state. Thus putting you in a position to undo/redo up to 6 times in a row, giving you the
freedom to experiment extensively.
The undo–redo function is accessible through the Edit menu or the toolbar.

2.7 Some Maths

To prepare a spectrum (here: ’RohSpec.spe’) for evaluation the following steps are needed
(This example refers to active DOAS):

• Offset correction (’OffsetSpec.spe’)

• Subtraction of the background light (’BackgroundSpec.spe’)

• Removal of the spectral and trend features caused by the lamp (’Lamp–Reference.sp2’)

• Extraction of the high frequency part of the spectrum, as it carries the differential
absorption information.

While performing these steps, some basic mathematical tasks will be introduced.
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• All spectra (background, lamp and roh) need to be offset corrected. To do so select
’BackgroundSpec.spe’. Then click on math→correct offset, choose ’OffsetSpec.spe’ out
of the list and press okay. Perform the same operations on ’Lamp–Reference.sp2’ and
’RohSpec.spe’.

• Select the source spectrum: If not already displayed in the active spectrum sheet, click
on ’RohSpec.spe’ in the Spec bar.

• Create a duplicate: Create a copy of the spectrum (Edit→Duplicate or tool button),
which will add a new pictogram to the Spec bar.

• Subtract background: Select the math→spectrum operations→subtract spectrum menu.
A dialog appears requesting the name of the spectrum to be subtracted from our copy
of ’RohSpec.spe’ (make sure the copy is in the active spectrum sheet). The dialog lists
all spectra that are held by the spec bar. Select ’BackgroundSpec.spe’ and click ’Ok’.
The spectrum graph will change only slightly, as the background intensity was only a
few percent of ’RohSpec.spe’.

• Remove lamp spectrum: Select ’Lamp–Reference.sp2’ from the math→spectrum operations→divide
spectrum menu to divide the background–corrected ’RohSpec.spe’–spectrum by the
lamp spectrum. The resulting spectrum already shows obvious absorption features,
superimposed on a declining trend, which will be removed in the next step by high–pass
filtering.

• High-pass filter: Select math→high pass or click the tool button. Change the number
of iterations to ’1000’ and click ok. The trend has been removed, and absorption
structures stand out clearly. There is still some noise that we will be removed in the
next step.

• Smoothing: Select math→low Pass or click the tool button. Chose ’5’ as the number
of iterations and click ok.

• Logarithm: Select math→logarithm or click the tool button.

• Save: Choose file→save as and select a location and a preferred name for your spec-
trum.
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Chapter 3

The DOASIS Menu

This chapter will give you an overview of all the possible buttons and commands that you
will find in your DOASIS Menu.

3.1 File

Figure 3.1: The file menu.

• To create a new spectrum, select the new command.
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• If you want to open an existing spectrum from your file collection, choose open.

• Open in active window opens a spectrum file and replaces the current spectrum with
the new one. Of course it will be opened either with the file or spectrum name according
to what was chosen in the active window.

• It is possible to save the spectrum in the active spectrum sheet by using the save
command. Note that the following file formats are possible:

– .spe will save the spectrum with all properties

– .mfc will save the spectrum with the most important properties

– .std is the ascii version of mfc

– .txt

– .dat

– .xs is a typical crossection file, which will save the wavelength information as an
extra column.

• To open or save a whole sequential of spectra choose the open sequential or save
sequential commands.

• You can save the spectrum in the active spectrum sheet under a different file name by
using the save as command.

• There is a possibility to save your spectrum in the active window as an .emf file using
the command export. If you do so you can reopen your spectrum later on with almost
any graphic program.

• To close a spectrum in the active spectrum sheet simply use close.

• If you want to close not only the spectrum in the active spectrum sheet but also all
the spectra that are currently open you can do so with the closes all command.

• Printing the spectrum in the active spectrum sheet is done by clicking on print. Here
you can also decide if and which properties of your spectrum shall be printed with
your spectrum by clicking on page set up.

• To save the current state of your session (including all spectra, the current layout,
math. . . ) for later use choose the save checkPoint command. To reopen this checkpoint
use restore checkPoint.

• If you want to exit the application simply use the exit command.

3.2 Edit

• With the undo command you can restore the previous state. This can be done up to
four times in a row.

• By using the copy command you can store an object temporarily in a buffer and than
paste it into a place you desire. When copying a spectrum it is possible to choose
whether to copy the whole spectrum data or only the currently selected row.

• The cut command is an extension of the copy command. It does not only copy the
selected spectrum but deletes the old one when doing so. After that it can again be
pasted into any chosen place.
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Figure 3.2: The Edit menu.

• If you want to simply paste a spectrum or part of it into a new window, copy the part
you want and use the paste into new command. This will paste the copied part into a
new spectrum sheet. This is a shortcut of the copy and past command since you don’t
have to open a new spectrum first.

• If you want to paste exactly the same spectrum as displayed in the active spectrum
sheet into a new spectrum sheet simply use the command duplicate.

• To split a multidimensional spectrum into a set of one dimensional spectra where each
spectrum is one data row of the multidimensional spectrum use the command split
spectrum.

• To cut of part of your spectrum, select the part you want to get rid of and choose the
command crop.

3.3 Acquire

• To start a scan with the previously set parameters (for example integration time and
number of scans) you can use the scan command.

• The dummy readout starts a suitable high number of scans and minimum integration
time. This is necessary to avoid the ”memory effect” of photo diode arrays i.e. clearing
residual structures of previous measurements. The resulting spectra are not displayed.

• To display the spectrograph controlling dialog use PDA/spectrograph. Further infor-
mation on this window can be found in 6.4.

• Auto scanning will perform scans until a defined saturation is reached using the HMT
serial controller.

• To get additional information about the ADC/DAC channels of the serial HMT Con-
troller System parameters choose system parameters. A pop up window will appear in
which the following entries can be viewed:

– Temperature of the ambience

– Temperature of the spectrograph
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Figure 3.3: The Aquire menu.

– Temperature of the PDA on the warm side of the peltier element

– Temperature of the PDA on the cold side of the peltier element

– Pt-1000

– Pressure of the ambience

All these parameters can be monitored over a period of time. To do so, activate the
ones you want by setting a check mark into the little box right next to them, choose
the intervals in which the results shall be displayed, how many times (defined through
the number of log lines) you want them checked and then simply click on the start log
button. Of course the logbook can be saved by using the save log button.

• PDI control

• With the outport control command you can control all 12V and 16V power supply
outlets.

• The shutter on/off command will move a shutter in front of your CCD camera or back
again.

• The mercury lamp which is used to calibrate spectra can be turned of or on by using
the HG lamp on/off command.

3.4 Math

• ·If you choose the command spectrum operations you can add, subtract, multiply or
divide the spectrum in the active spectrum sheet by a spectrum of your choice. When
doing so note that the spectrum in your active spectrum sheet will be overwritten.
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Figure 3.4: The Math menu.

• You can also add, subtract, multiply or divide a constant to the spectrum in the active
spectrum sheet if you choose the command scalar operations. Again the spectrum in
the active spectrum sheet will be overwritten.

• If you want to correct the offset of the spectrum in the active spectrum sheet you will
find a correct offset command, which takes into account that you may have different
iteration times and different numbers of scans. Just click onto the spectrum you want
to correct, choose the correct offset command and insert your offset spectrum into the
blank box.

• It is also possible to correct the dark current with the command located in the math
bar using the same steps already described above.

• The low pass binomial command will perform a low pass binomial on the spectrum
in your active spectrum sheet. The binomial filter uses the smallest binomial mask
possible. This mask does the same as an averaging operation over three contiguous
channels. Doing this will smooth out the spectrum, removing noise.

• The high pass binomial command will perform a high pass binomial on the spectrum
in your active spectrum sheet. This means it will first do a low pass filter and will
then divide your spectrum by the result of this low pass filter operation. This is very
useful if you want to eliminate all your broadband structures.
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• You can convolute a cross section with the instrumental function by using the convolute
command.

• It is possible to take the logarithm or the exponential of the spectrum in the active
spectrum sheet by using the corresponding commands.

• If you use the shift command you can shift the spectrum in the active spectrum sheet
by as many channels or wavelengths as you fill into the blank box. The spectrum will
be shifted to the right if you fill in positive numbers and vice versa. Note that if you
shift your spectrum out of the diagram and than back into it, all the channels, which
reappear, will be set to the value of the last one displayed.

• The squeeze command will squeeze the spectrum by the value, which you fill into the
blank box.

• If you are using the sun as your light source you will have to correct the ring effect.
You can do this by using the ring spectrum and raman spectrum commands.

• You can invert, take the reciprocal of a spectrum or reverse a spectrum by using the
corresponding commands.

• By using the zero out command all the data of a spectrum below the limit, which you
can fill into the pop up window, will be set to zero.

• If you choose the normalize amplitude command you can scale a spectrum in such a
way, that the maximum value of the spectrum will correspond to a value of your choice.
For example if you normalize the spectrum to 1 the spectrum will be multiplied by
1/(maximum value of the spectrum).

• The normalize energy command will normalize the surface area of the spectrum in the
active spectrum sheet to the value that you fill into the menu of the pop up window.
This is especially useful if you want to convolute as the convolution is not supposed to
affect the order of magnitude of the spectral values. Considering this it is necessary to
normalize the convolution core. In other words its area has to be one. Through this
you can for example take the spectral line of a mercury lamp as a convolution core,
normalize the surface area by using ”normalize energy” to one and then convolute the
line.

• Using the bias adjust command will subtract the mean value of a spectrum from itself.

• If you want to fourier transform the spectrum in the active window sheet just use the
FFT command and if you want to do an inverse Fourier transformation use the inverse
FFT command.

• The gauss pyramid is a set of low pass filtered spectra, which have been calculated
out of the spectrum in the active spectrum sheet. In doing so each partial spectrum
of the gauss pyramid only uses half of the frequencies of the previous spectrum. By
doing so one achieves spectra of which the first one matches the original spectrum, the
second one is smoothed in such a way that it only contains half of the frequencies of
the original spectrum and so forth. Note that we are talking about frequencies of the
Fourier transformation of the spectrum not the wavelengths.

• The LaPlace pyramid does in principal the same as the Gauss pyramid. The only
difference is that the smoothed spectrum is subtracted from its preceding spectrum
thus achieving a set of spectra where the first one only consists of high frequent parts
of the spectrum and the last one only of low frequencies.

• Last but not least you can perform a Gauss fit on a spectrum by using the Gauss fit
command.
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3.5 Data

Figure 3.5: The Data menu.

• To fill the active spectrum sheet with random data use fill random. Use the number
entry to define around which number you want to scatter.

• You can also fill the active spectrum sheet with a gauss curve. To do so choose fill
gaussian. A window will appear in which you can set an x - value and a sigma.

• The third option is a polynomial. This is done by using fill polynomial after which a
window will appear in which you can choose all the necessary parameters.

• To do a wavelength calibration of your spectrum the calibration assistant can be used.
The calibration works as follows:

– Scan an HG spectrum or any other kind of spectrum. The important issue is,
that the wavelength of at least three or more features of the spectrum are known.

– Place the marker in the middle of the feature/peak.

– Enter the wavelength value of the marker’s current position.

– Press the add button.

– Repeat the steps described above for all the known features. The more data
points are available the better the result will be (but at least three wavelength
positions are required to calculate the dispersion).

– Press the done button.

If the wavelength dispersion is calculated successfully, the result will be displayed
on the current spectrum and the x–axis will be scaled in wavelengths rather than in
channels. Note that the wavelength dispersion is determined using a polynomial of
the order two.

• To find out more about import calibration data command see 7.

• The frequency distribution is given under the histogram command.
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Figure 3.6: The Stepper menu.

3.6 Stepper

• If you choose the move stepper command a pop up window will appear. With this
window you can control all your motors. For example if you choose teles horizontal the
motor number one will be activated (if you want to move your telescope in a horizontal
direction it will have to be jumpered on the motor card as motor one otherwise what
ever is jumpered as motor one will move) and so on. You can now decide how far the
motor shall move. Note that there are two ways to do so: If you activate the move
relative command the motor will move by as many steps as you tell him starting from
the position it is already in. If this command is not activated the motor will move to
the number you typed into the box meaning it will go to position (for example) 200.
The current position is always displayed in the upper left of the window. By using the
home button the motor will move to position zero. You can also set and save the start–
and end – frequencies with which your motor shall be accelerated in this window.

• Filter wheel

• Lamp list

• Telescope

• Configure optimization

3.7 Extras

• Dynamic data exchange will open a communication protocol with which you can com-
municate with other programs.

• Options

3.8 View

Docking windows

• If you use the reset workspace layout command your workspace will be arranged, in
particular the docking windows, according to the initial state.
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Figure 3.7: The Extras menu.

Figure 3.8: The View menu.

• The following commands will initialise docking windows in which different operations
can be performed: console, script, mini scripts, quick scripts and fitting. For further
information about how to use these docking windows please see 4.

• The commands statistics, properties and fit result will open a docking window in which
you can find detailed information about your spectrum. Please also check 5.

• By choosing specbar a docking window will be initialised, in which you can manage
your spectra collection.

Markers

• If you need a marker the show marker button will show or hide the marker in your
active spectrum sheet.

• The show math marker command will create a coloured array, which you can move,
minimize and enlarge, as you like. All mathematical operations you then wish to
perform will only be applied to the coloured part of the spectrum.

• You can also choose to limit your fitting operations to a small part of your spectrum.
To do so the show fit marker command will create a coloured array, which you can
move, minimize and enlarge, as you like. Again all fitting operations you then wish to
perform will only be applied to the coloured part of the spectrum.

• The show OD marker command makes it possible, to select a region of your spectrum
in which the optical density shall be calculated.
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• Apart from just defining one fit range with your fit marker it is possible to add an
other fit range on top of the original one by using the add fit range command. This
range will then be weighted double.

• To remove fit ranges the remove fit ranges command will remove all previously added
fit ranges.

Multidimensional Data

• To select the first spectrum in a multidimensional spectrum use the First row com-
mand.

• To select the previous spectrum use Previous row and for the next spectrum use Next
row.

• The Last row command will select the numRows-1 spectrum in a multidimensional
spectrum.

• row

• If you want to overlay the spectrum in the active spectrum sheet by another spectrum,
you can select the add overlays command. This will overlay the spectrum in the active
spectrum sheet with a spectrum of your choice. You can choose between two options:
Normal – this will simply overlay your spectra Fit all overlays – this will not only
overlay your spectra but also fit them while doing so.

• The remove overlays command will simply remove previously added overlays from
your active window.

• You might want to compare two or more spectra with each other without overlaying
them. To do so just select the add multi charts command with which you can display
the spectra next to each other.

• Of course you can remove previously added spectra with the remove multi charts
command.

• When choosing the terminal command a window will open which will allow a direct
communication via serial interface.

• If the minimize to tray command is enabled, the DOASIS window will vanish out of
the taskbar when minimized and will appear as a small icon right next to the clock
instead. From there it can be reopened through a double click.

• Through the show wavelength command you can determine if wavelength information
shall be displayed or not, of course this will only apply to spectra which contain
wavelength information in the first place (if you are not sure whether your spectrum
contains this information or not, just check your spectrum properties under the entry
”is wavelength valid”).

• If you choose to display markers a coloured array will appear. Since it is sometimes
more convenient to simply display coloured lines especially when overlaying marker
ranges you can do so by activating show marker range.
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Figure 3.9: The Help menu.

3.9 Help

• If you choose the content command you will be shown an overview over the chap-
ters and topics of the documentation.· Where as the index command will show an
alphabetical order of the commands and topics used.

• To load the Jscript documentation or the programming documentation use the corre-
sponding commands.

• About DoasUI will display who the credits for DOASIS go to.

3.10 Toolbars

For some of the menu entries a shortcut is available through the toolbars below the menu
bar. The idea behind the toolbars is to make it easier for the user to do the same tasks over
and over again. For example, if a menu function requires additional parameters you will be
asked for them when you select the menu entry from the menu bar. To make the access to
these functions faster, using the appropriate toolbar button executes the same action except
the the user will not be asked for additional parameters again. Using the toolbar button
will use the last function parameters unless they are invalid for some reason.
Here is a short example. If you choose the ’Subtract Spectrum’ menu entry under the Math
menu, you’ll be asked for the spectrum that should be subtracted from the current one. The
next time its enough to press the ’Subtract Spectrum’ button from the math toolbar. This
will automatically subract the spectrum selected the last time the menu entry was used. If
the spectrum does no longer exist, you’ll be asked to define a new operand again.
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Chapter 4

The Console Window

In the console window you will find the Output, Script, Miniscript, Quickscript and also
the important Fitting window. These windows are already available at the start–up of the
DOASIS program. If you choose to close the console window you can restore the windows
individually via the view→docking windows path.

Figure 4.1: The Console window which has the Output tab selected.

4.1 Output

4.2 Script

The script dialog gives you access to the automation module for DOASIS. In the commando
line you can enter the path of an existing Jscript or use the browse button. With the edit
button the actual script will be opened for modification with an editor. You can set your
preferred editor in extras→options→jscript.
With the start/stop/pause buttons the active script will be executed, stopped or paused. Be
careful with the stop and pause buttons though: stopping requires a corresponding polling
in your script (more in Jscript for dummies ? checkstop function). To pause means to
suspend the execution of your script as well as the whole DOASIS program. When starting
the script execution your script will be precompiled before it is executed. As default option
script errors will appear in the console window. You can also choose the detailed error report
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by choosing report full error information. (For further information about creating, handling
and debugging Jscripts see – ”Jscript for dummies”, which will be coming soon!)

4.3 Miniscript

In the miniscript window you can easily type short scripts, which can be executed immedi-
ately. The most important functions for typical DOAS applications are already imported in
the predefined header. More details and examples can be found in the J-Script for dummies
documentation.

4.4 Quickscript

In the Quickscript window you can define short cuts for J-Script applications. Just choose
one of the predefined short cuts from the list, double click on the line and a browsing window
will open. Here you can choose a script application for your short cut. You can optionally
define these short cuts system wide by activating this option in the header of the console
window. This means, that even if the console menu or the Doasis program are inactive, the
script, defined by the short cut, will be executed.

4.5 Fitting and Fitting Example

This chapter will explain, how to set up/create a fit scenario, execute a fit and store the
results in a file for further use.

Restore checkpoint
To make things clearer please load the checkpoint fitting example via the File→RestoreCheckpoint→Fit Example.ckp
path.
The example you have just opened is taken from measurements of an active–longpath DOAS
set–up. It contains four spectra: The MeasSpec is the spectrum, which shall be evaluated.
The other three spectra are reference spectra: The Lamp Reference – a spectrum, which
contains the lamp structures. The Iodine–oxide and NO2 reference spectra, which are used
for the evaluation of the concentrations in the atmospheric spectrum (MeasSpec).
All these spectra have already been corrected – meaning, that offset and background correc-
tions have been done for the Lamp reference and the MeasSpec and that the cross-sections
of IO and NO2 have already been convoluted with the instrumental function.

Choose Fit-Range
The best way to start setting up a fit scenario is by choosing an expedient fit range. To do
so it is useful to overlay the reference spectra with the atmospheric spectrum.
You will find the overlay–command under view→add overlay.
When you overlay the IO and the NO2 reference spectra with the atmospheric spectrum
choose the ”fit all overlays” option – otherwise the y–axis will be scaled from zero to the
maximum value of the spectra, which will not be helpful in this case.
Now you can easily choose a good fit range by using the view→markers→show fit markers
path.
In our example we will choose a fit–range, which includes the three strongest bands of IO
(∼ 475 – 760). Simply place the fit markers in such a way, that these bands are within the
colored range of your fit markers.

Fitting-options
In the console window you will find the fitting window. In the left part of this window is a
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list in which you can enter the references that shall be fitted to your spectra.

Please note: Doasis does not distinguish between cross sections and references. If you
enter the cross sections of NO2 and IO without any modification into this list - the fit
coefficients will be negative. On the other hand the lamp reference is an absorption
spectrum. The easiest way to avoid confusions is to invert your cross-sections before
working with them.

To add a reference spectrum or a cross section to the list – you have to open the menu by
double clicking on one line of the list. In the menu that opens you will again find a list of
all spectra in the specbar.
Please choose the IO, NO2 and Lamp reference for the fit–scenario.
For each reference of the list you can now choose the settings individually by clicking on
the reference spectrum with the right mouse. This will open the fitting properties window,
which consists of three parts. Since these three parts have a similar structure they will be
explained conjointly:

Shift/Fit coefficient/Squeeze:

• The default parameter for each fit–option is normal – which means that there are no
limitations or dependencies on the fit.

• You have the possibility to fix the resulting values (shift/squeeze/concentration) to a
defined value.

• You can add limits to the fit parameters – e.g. exclude negative values for the concen-
tration.

• You can also link the parameter to another reference – e.g. if the shift of IO shall be
identical to the shift of NO2 you can link the shift of the IO reference spectrum to the
NO2 reference spectrum.

In our example, to make things a little easier, we will stick to the default values. Do feel
free though to try out some of the options as you move along.

Polynomial degree
In the centre of the fitting window you can choose different polynomial degrees – detailed
information on the resulting polynomial will appear in the list after the fit procedure. Infor-
mation about the Chi–Square and the Fitsteps will also be shown in this part of the window
after the fit procedure.

More fitting properties
There are five buttons on the right side:

• The first button will execute the fit scenario that you have configured in the chosen
fit–ranges with the spectrum in the active spectrum sheet.

• The second button allows you to save the actual fit scenario into a file with a name of
your choice.

• With the third button you can load an existing fit scenario.

• The fourth button contains additional fitting properties:
You can optionally decide to take the logarithm of the spectra automatically before
the fit is executed (another possibility is to do this by pre–processing your spectra
with a J–script).
Further more you can limit the fit iteration steps to a maximum value. For addi-
tional information on the evaluated spectra look at the entries made in the spectrum
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properties. You can choose from a list which entries shall be stored together with the
fit–results in an ascii-file. The name of the file can be selected freely.
You can decide if you want to have additional header lines incuded at the top the fit
result file. These lines include information about the DOASIS version used, the date
and time of creation and the current fit scenario file name. The user can also add
his/her own comment to be inluded.

• To save these values (including additional information from the spectrum properties)
to an ascii-file use the fifth button.

Execute Fit-scenario
To execute the scenario please click the first button with the exclamation mark. The fit
results of the reference spectra on the list, the polynomial and the residuum will appear in
a multi-chart view sheet for supervision.
In the multi-chart view, the reference spectra multiplied with the fit coefficient are overlaid
with themselves with an added residual. Additionally the calculated result–spectrum on the
multi–chart will also be available in a single sheet in the taskbar and in the specbar.
You now have the option to save single spectra or to print them (see menu entry file→print→multi-
chart).
All calculated parameters, like the fit coefficient, the shift and squeeze results and the iter-
ation steps of the scenario appear in the fitting window.
You can now save these values into an ascii–file with the fifth button.
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Chapter 5

The Information Window

This chapter will give you a short overview over the features that can be found in the
information window. You will find that it is divided into three separate windows: The
Statistics, Properties and Fit Results window.

5.1 Statistics

Marker

• Here you can find information about your marker. You can see which channel or
wavelength the marker is placed on and also which value on the y–axis this corresponds
to

Optical density

• Delta

• DeltaRel

• The value of your optical density is given in the opticalDensity box.

Statistics

• All the math info can be found here: The average gives you the average value of
your spectrum, the deviation and variance of your spectrum can also be found here.
Another important figure is given in the max and min lines: These tell you what
maximal and minimal values your spectrum has.

5.2 Properties

Information
In this window you will find important information about your spectrum such as:

• The centerWavelength is only given for backwards compatibility, all users who work
with DOASIS for the first time should simply ignore this entry.

• Which elevationAngle you where at.

• How long your exposureTime was.

• The name of your spectrum.
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• How many scans where made (numScans)

• What the startDate was.

• What the startTime was.

Information Details
Further information that might be needed will be given in this section:

• Which altitude you where at.

• Who the author was.

• At what azimuthAngle you where.

• Which device was used.

• flags

• gain

• At what latitude the scan was made.

• How long the lightPath was.

• What kind of lightSource was used – meaning what kind of lamp or maybe the sun.

• At what longitude the scan was made.

• Whether this is the original spectrum or if it has already been modified.

• multiChannelCounter

• objectKey

• What the pressure of your ambience was.

• Any remark can be added here.

• scanMax

• What the site was called

• At what time the scan was stopped (stopTime)

• What the temperatureAmbient was.

• The wavelengthLinearDispersion is only given for backwards compatibility, all users
who work with DOASIS for the first time should simply ignore this entry.

Marker

• The entries fitHigh and fitLow will show you the exact channel or wavelength your fit
marker is located on.

• You can find the position of your marker given either in channels (marker) or wave-
lengths (markerWavelength) as well as its corresponding position on the y–axis (mark-
erValue).

• You can find the exact location of your math marker by checking the mathHigh and
mathLow entries.
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• In order to set a maximum or minimum value for your x–axis, enter the numeric values
in the boxes maxChannel or minChannel

Marker (Advanced)

• If the enableMathMarker is set to true any mathematical operation is limited to the
data selected by the math range. Otherwise always the whole spectrum will be affected.

• The position of the optical density marker is given by three different entries: The
centre is given by the opticalDensityCenter entry, the left by the opticalDensityLeft
entry and the right by the opticalDensityRight entry.

Spectral data

• The calibPolynomial gives you the used polynomial for your dispersion equation.

• If isWavelengthValid is set to true the data array listed under the wavelength–property
contains valid channel–to–wavelength information. Otherwise the data array contains
only channel numbers.

• The number of channels used is dependent on whether you measured with a PDA or
CCD array and is given under Nchannel.

• NumRows

• Rows

• SelectedRow

• SelectedRowIndex

• Wavelength

Statistics

• You can see the average of your spectrum in this box.

• The peak-to-peak distance is given in the delta box.

• Under deltaRel you will find the root mean squared of your delta.

• The maximum and minimum values of you spectra are given in the max and min
boxes.

Statistics Details

• deviation

• Of course you can find the opticalDensity and its variance in the corresponding boxes.

View

• The title of the x–axis is given by ChartXAxisLabel

• Your y-axis is charted automatically by default to change this setting, double click on
chartYAxis and it will be set to fixed.

• The title of the y–axis is given by ChartYAxisLabel
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• If you want to set a maximum or minimum value for your y-axis you can do so by
making an entry under chartYAxisMax or chartYAxisMin.

• The overlayMode entry is set to normal by default and can be changed to rescaleOver-
lay by double clicking on it.

5.3 Fit Results

• coefficient

• coefficientDefault

• Shift gives you the calculated shift of your spectrum. That you need to shift the
reference spectrum might be necessary if for example the temperature of your measured
spectrum isn’t the same as the temperature of the reference spectrum.

• ShiftDefault contains the initial value of the fit.

• The error of your shift is given under shiftError.

• How far your reference spectrum was stretched or squeezed is given under squeeze.
The reason why it is necessary to do so might be that a PDA structure needed to be
corrected.

• SqueezeDefault contains the initial value of the fit.

• Again, the error of your squeeze can be found under squeezeError

29



Chapter 6

Controlling Hardware With
DOASIS

6.1 Instruments that can be controlled by DOASIS

• Acton

• HMT AutoScan

• HMT Fixed Grating

• HMT USB MicroStepper

• HMT USB MultiStepper

• Mini DOAS

• Jobin Yvon using a serial HMT controller

• Ocean Optics:

– ADC 1000

– USB 2000

– USB 2000+

– USB 4000

– HR 2000

– HR 4000

– QE 65000

• Slotted Disc Machine

• Triax

6.2 How to connect an Ocean Optics spectrograph to a
measurement PC

This section covers how to properly install the Ocean Optics drivers on a measurement PC
and how to connect a new Ocean Optics spectrograph to this PC.
As an example, the USB 2000 is used, but it could be any other Ocean Optics spectrograph
supported by DOASIS (see 6.1).
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Ocean Optics software can be downloaded from here:
http://www.oceanoptics.com/technical/softwaredownloads.asp

1. Install Ocean Optics OOIWinIP (version 4.0.11.6 or newer).

2. Install Ocean Optics OOIBase32 (version 2.0.6.5 or newer).

3. Connect the USB 2000 to the USB port of your PC. If you connected it before step 1,
then Windows may have installed some wrong drivers by itself. In that case, plug the
USB 2000 out, uninstall its driver, follow steps 1 and 2 and then plug it in again.

4. Windows informs you to have found a new device. In the first dialogue, decline to
connect to the Windows Update. In the second one, let the software be installed
automatically. You should now get a message saying that the USB 2000 was installed
properly.

5. Start OOIBase32, select the USB 2000 and make sure that it works, i.e. that it reads
out the spectra and displays them on the screen.

6. Close OOIBase32.

7. Start DOASIS, in the field ”device” select the USB 2000 and see, if its serial number
shows up. If the serial number does not show up, close DOASIS, start once again
OOIBase32, let it display the spectra of the USB 2000 again and close it.

8. Now, DOASIS should display the serial number of the USB 2000. If so, then it has rec-
ognized it and from now on, you won’t need the step of initialization using OOIBase32
anymore.

Note: Please keep in mind of not having OOIBase32 and DOASIS running at the same
time. Both will try to access the spectrograph and may slow each other down or block
completely each others access to the hardware.

6.3 How to operate two Ocean Optics spectrographs
with DOASIS at the same time

The driver of Ocean Optics does not support the usage of more than one spectrograph at
the same time. Thus, DOASIS has been programmed to handle more than one spectrograph
anyway.
To operate two Ocean Optics spectrographs at the same time, one also needs two instances
of DOASIS running simultaneously. In detail, please follow these steps:

1. Connect both spectrographs to your PC. Make sure, that their drivers are installed
correctly (therefore, see 6.3).

2. Start OOIBase32 and choose one of the spectrographs, called ”spectrograph 1” in the
following.

3. Close OOIBase32 and start the first instance of DOASIS.

4. In this instance of DOASIS, you should be able to operate the spectrograph 1 as usual.

5. Open the second instance of DOASIS. In the field ”device”, select the other spectro-
graph, called ”spectrograph 2” in the following. You should be able to choose the
spectrograph, but not to alter the diplayed serial number in the field ”USBSerial”.
This one probably still shows the serial number of the ”spectrogrph 1”.
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6. Close the second instance of DOASIS. At the moment, you have only one (the first
one) instance of DOASIS open. Now, start again a second instance of DOASIS.

7. In this second instance, the field ”device” should already show the correct type of the
”spectrograph 2”. But now, you should also be able to overwrite the ”USBSerial” with
the correct serial number of the ”spectrograph 2”. Please do so.

8. Now, you can use both Ocean Optics spectrographs, each one with its own instance of
DOASIS, at the same time.

Note:

• After closing both instances of DOASIS or after rebooting the PC, please start again
with the second item.

• For how to operate two Ocean Optics spectrographs with two different JScripts, please
see in the JScript Tutorial the chapter ”How to operate two Ocean Optics spectro-
graphs with two JScripts at the same time”.

6.4 Examples

Example Acton/Longpath
An example for setting up measurements of a typical Hoffmann/Acton combination is given
here:
It is required, that you correctly connect one COM port of your PC to the Hoffmann con-
troller with a serial cable. In the menu: acquire→PDA spectrograph a dialogue opens, where
you have to enter all required settings for your system.
First you choose the spectrograph type as the correct device (in the top of the window) –
in our case this will be the Acton. In the HMT serial communication the following settings
are suitable:
The baud rate is 57600kB. In the port HMT menu point you have to enter the correct port
of communication. In test communication you can choose the option: test communication,
which will give you the information if DOASIS found the correct hardware on the given
port. Additionally in the console window a message appears if the initialisation succeeded
or failed. After a successful initialisation of the new device you can start your measurements:

In the device settings you can choose the grating and the wavelength for your measurement,
whereas you can choose the exposure time and scan number in the scan settings:

• Scan: This button will start the scan with the chosen settings.

• Initialise is still not properly working – but should check the serial communication
with the HMT controller.

• Device will open a window where all scan settings are more clearly arranged.

• Dummy readout : This button is used to clear the PDA from remaining structures
of previous measurements. This is realised by reading out the PDA with a suitable
high number of scans and minimum integration time. The resulting spectrum is not
displayed.

Example Ocean Optics/scattered light
To work with Ocean Optics you will have to install Hoffmann USB Aktive X Control Soft-
ware and Ocean Optics and you need to connect the instrument to the USB.
At first you have to start Ocean Optics and choose connecting to the first available USB2000,
the program should then find the right serial number. If not select the right serial number
and have a look at the displayed spectrum. Now, when you start Doasis a window called

32



configure hardware appears, in which you can choose the Spectrograph Type and several
other settings. After you have selected the appropriate settings click ”ok” and Doasis will
open.
Use aquire→PIDControl to open a new window where you can set the desired temperature
of your spectrograph by entering it into the provided field.
Wait until the actual temperature is constant and in the range you want to have before
proceeding.
Use aquire→PDA/Spectrograph to open the PDA/Spec-Window. Under device you can
choose the Ocean Optics USB 2000 and under scan settings you can set exposuretime [msec]
and the number of scans (note that the lowest exposuretime your Ocean Optics can handle
is 3msec). Choosing the command scan will now start a scan.
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Chapter 7

Advanced Topics

This chapter will describe some of the more complex functions of Doasis like wavelength
calibration and reference spectra preparation.

7.1 Wavelength Calibration

Doasis allows the definition of a channel-to-wavelength calibration polynomial. This poly-
nomial can be defined for each spectrum separatly thus each spectrum can have a different
wavelength scale. Additionally the calibration polynomial can be set as default for new
spectrum object as well as be used by the spectrograph devices as their default calibration.
To define the calibration polynomial you can choose the manual way by defining the cali-
bration polynomial coefficients using the properties windows of the spectrum or you can use
the Calibration Assistant to determine the calibration polynomial using a least squares fit.
To use the Calibration Assistant do the following:

1. Record a spectrum where you know the wavelength of at least 3 features within the
spectrum eg. a HG-spectrum.

2. Start the Calibration Assistant from the Data menu.

3. Press ’Next’.

4. Place the Marker on one of the known spectrum features.

5. Press the ’Get Marker’ button in the Calibration Assistant. The current marker posi-
tion should appear in the text box left to the button.

6. Enter the wavelength of the feature in the next textbox and press the ’Add’ button.
The channel-wavelength data point will be added to the list on the left side.

7. Repeat step 4. at least two times. Its necessary to define at least 3 different channel-
wavelength data point. The more data points given, the more acurate the calibration
result will be.

8. Once you’ve defined enought data points press ’Next’.

9. Define the order of the resulting polynomial. Normally it should be sufficient to use a
polynomial of order three or less.

10. Press ’Next’

11. If the polynomial fit was successful, you should now see a plot of the determined
polynomial. To change the polynomial use the Back-buttons. Otherwise press ’Next’
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12. Now you need to define where the polynomial should be used. You have the following
options:

• Current Spectrum The polynomial will be used in the current spectrum.

• All open spectra The polynomial will be used in every spectrum listed in the
Specbar.

• Default for new spectra The polynomial will be used as default calibration poly-
nomial for new spectra.

• Current spectrograph The polynomial will be used by the currently selected spec-
trograph. Any spectrum recorded with this device will then get the spectrograph’s
wavelength calibration.

13. Press ’Next’ and ’Finish’. That’s it!

Howevery you can always remove the wavelength calibration by deleting the polynomial’s
coefficients of if you set the ’IsWavelengthValid’ property to false.

7.2 Convolution and Downsampling

To use a high resolution reference spectrum with you measured data, its necessary to prepare
the reference spectrum in a way that the aperture function of your spectrograph will be
simulated. A good approximation for the aperture function is to record a very sharp peak
with your spectrograph and than convolute the reference spectrum with the recorded peak
and downsample the spectrum to the wavelength calibration of the spectrograph. The
convolution can be done in Doasis very easily although the convolution tool does a general
convolution using a given kernel function.

1. Prepare a spectrum that represents the convolution kernel. Eg. record a HG spectrum.

2. Please the Math Marker around the convolution kernel. (Select one of the peaks in
the HG-spectrum).

3. Place the Marker on the center of the convolution kernel. (Set the maker right in the
middle of the HG-peak). You can also use the ’Auto search kernel center’ feature in
the convolution dialog. In this case its not necessary to place the marker manually.

4. If the convolution result needs to be resampled to another wavelength range, create a
spectrum that is calibrated to the desired wavelength range.

5. Open high resolution reference spectrum and make it the visible one.

6. Select ’Convolute’ from the Math menu.

7. Select the spectrum that represent the convolution kernel.

8. Select either the spectrum that holds the target wavelength information or the refer-
ence spectrum. If you select another spectrum as convolution target than the reference
spectrum itself, the convoluted spectrum will be resampled to the wavelength range
defined in the target spectrum. Otherwise just an inplace convolution on the reference
spectrum will be done.

9. If you want the convolution to find automatically the center of the convolution ker-
nel, check the ’Auto search kernel center’ checkbox. If enabled, the convolution will
assume that the maximum value inside the math limits represents the center of your
convolution kernel.

10. Select on of the convolution kernel options:
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• Normal convolution kernel Use this option if the convolution kernel should be
used as it is. No rescaling or anything else will be applied to the kernel.

• Normalize convolution kernel In this case the convolution kernel will be normal-
ized like defined in equation 7.1. This option should be used when a reference
sectrum will be prepared with a HG-peak, since the normalization will ensure
that the scale of the reference spectrum will stay the same and only a smoothing
operation will be applied.
The normalized kernel k(x) of a given convolution kernel s(x) with the given
math range l . . . h is given by the following equation:

k(x) =
s(x)− smin∫ h

l
s(x)− smindx

(7.1)

smin = min s(x)|l ≤ x ≤ h (7.2)

11. Press ’OK’ to start the convolution.

Note: If one of the three spectra required for convolution does not contain a valid wavelength
calibration, the convolution will work on channel basis. Therefore the downsampling to the
target wavelength will result in a simple resampling of the whole reference spectrum to the
number of channels of the target spectrum.

7.3 Fitting

Essential for a DOAS analysis is the non linear fitting. Doasis makes fitting quite easy using
the Fitting tool in the console window. A simple fit can be done doing the following steps:

1. Prepare your measurement spectrum and reference spectrum.
Note: If one of the spectra used for fitting does not contain a valid wavelength
calibration, the fit will operate on channel basis!

2. Select your measurement spectrum and define the desired fit ranges.

3. Select the fit window.

4. Select the reference spectra used for fitting by clicking on the first column on one of
the lines of the list box. Select the reference from the drop-down list.

5. Define special parameter setting for each reference by double-clicking on the a reference
entry or using the button at the end of the line. The current fit implementation allows
to:

• Define a different start value for a parameter.

• Fix any parameter to a defined value.

• Limit any parameter to a given range. If ’hard limit’ is used, the fit will ignore all
results where a parameter is outside the valid range. Using soft limits still allows
invalid parameter values, but the result gets a penalty that increases exponentially
the more the parameter is outside the valid bounds.

• Link any parameter to another spectrum.

6. Open the fit properties dialog.

7. Define whether the measurement spectrum should be logarithmed by the fit or if its
already in logarithm space.
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8. Select the spectrum properties that should be store in a result file as well.

9. Select the desired fit model and define the additional model parameters.

10. Define the fit range. If you press the ’Get from current spectrum’-button, the fit ranges
of the current spectrum will be used.

11. Close the properties dialog.

You can now start fitting or first save the complete fit settings into a scenario file. The next
time you want to use the fit settings, its enough to open the fit scenario file. All required
information as well as all reference spectral will be loaded than from the scenario file.
If you set any polynomial order to less than zero (< 0) the polynomial will not be used
during the fit. Currently its possible to add two polynomials: The usual DOAS polynomial
and an additional offset polynomial.
It you choose to use the DOAS fitting model, the well known DOAS equation is used as
model function for the fit. Starting from the DOAS equation given by:

I(λ) = e
∑
ciσi(si+tiλ)+P (λ) +O(λ) (7.3)

(7.4)

we transform everything into logarithm space to get at least some linear parameters.

ln(I(λ)−O(λ)) =
∑

ciσi(si + tiλ) + P (λ) (7.5)

ln
(
I(λ)

(
1− O(λ)

I(λ)

))
=

∑
ciσi(si + tiλ) + P (λ) (7.6)

ln(I(λ)) + ln
(

1− O(λ)
I(λ)

)
=

∑
ciσi(si + tiλ) + P (λ) (7.7)

For very small O(λ)
I(λ) we get

ln
(

1− O(λ)
I(λ)

)
≈ −O(λ)

I(λ)
(7.8)

and we can use

ln(I(λ)) =
∑

ciσi(si + tiλ) + P (λ) +
O(λ)
I(λ)

(7.9)

for DOAS fitting, where I(λ) is the already high pass filtered measured spectrum. ci is the
fit coefficient, si the shift and ti the squeeze value of the reference spectrum σi(λ). P (λ)
denotes the DOAS polynomial and O(λ) the additional offset polynomial. Although the
offset polynomial O(λ) is not exactly correctly represented in this case. But the results are
nummerically more stable and therefore this method should be the prefered one to evaluate
the data.
Selecting the intensity fitting model, the evaluation is done in intensity space. The intensity
fitting model evaluates O(λ) correctly by using the following equation:

I(λ) = e
∑
ciσi(si+tiλ)+P (λ) +O(λ) (7.10)

If the fit was successful, you should see a result overview to visually ensure the result if
correct. The exact results of the different species will be display in the fit window. Using
the ’Append to Result File’-button stores the fit results in the selected ASCII file.
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Note: If all reference spectra and the measurement spectrum have a valid wave-
length calibration, the fit automatically operates in wavelength based mode.
Thus any parameters are now given in wavelength units! This includes any
parameter limits or fixed values defined in the fit scenario!
If at least one spectrum is missing a valid wavelength information, the fit works
in channel based mode and all parameters are given in channels then.
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Chapter 8

Glossary

In this section the commands avaiable in DOASIS will be described in greater Detail.
Since most commands are also available in JScript, the syntax will also be explained.

8.1 Math Menu

All math operations are applied to the range that is marked by the math marker, which is
the selection highlighted with a green colour.

8.1.1 Scalar Operations

The scalar operations are applied to the current spectrum sheet. The current spectrum will
be overwritten by the new spectrum. Since in both intensity spectra and optical density spec-
tra the y-axis values are realized as of data type double, one can add/substract/multiply/divide
a constant to the spectrum by specifying this constant in the popup window. You can use
both decimal or exponential notation, e.g. 4.25e− 05 instead of 0.0000425. For each scalar
operation, the popup window will remember the last number to make it easier to apply the
same scalar operation to different spectra.

Warning: Division by zero causes no error, but sets the value to zero.
Therefore, if a spectrum is divided by zero, the intensity is set to zero
everywhere.

JScript Syntax: Some examples with the constant 2.5 applied to the
current spectrum sheet:

SpecMath.Add(Specbar.CurrentSpectrum,2.5);
SpecMath.Sub(Specbar.CurrentSpectrum,2.5);
SpecMath.Mul(Specbar.CurrentSpectrum,2.5);
SpecMath.Div(Specbar.CurrentSpectrum,2.5);

8.1.2 Spectrum Operations

Spectrum operations are such as channelwise addition, subtraction, multiplication. In con-
trast to the scalar operations, the current spectrum is not modified by a constant, but each
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channel is modified by the value of the same channel in the reference spectrum, which has
to be specified in the dialog box.
Notice that spectrum operations require that both current spectrum and reference spectrum
have the same range of channels/wavelengths. If this is not so, an error may occur.
There are three modes how to modify the current spectrum by spectrum operations:

• normal: the values of a certain channel are added/subtracted.

• scan weighted: before addition/subtraction/..., the reference spectrum is
muliplied by an overall factor, namely the ratio NumScansspecCur/NumScansspecRef .
This command is for example useful to reduce scan-dependen effects (like
offset correction).

• time weighted: before addition/subtraction/..., the reference spectrum is
muliplied by an overall factor, namely the ratio NumScansspecCur∗ExposureT imespecCur

NumScansspecRef∗ExposureT imespecCur

, which is the ration of the overall scan times (toverall = NumScans∗ texposure)
This command is for example useful to reduce time-dependend effects (like
dark current correction).

JScript Syntax: For example, if the Specbar contains a spectrum named
”RefSpec”, a scan-weighted addition is done by

SpecMath.Add(Specbar.CurrentSpectrum,Specbar.Spectra["RefSpec"],
SpectrumOperandMode.ScanWeighted);

For time-weighted spectrum operations, the flag
SpectrumOperandMode.TimeWeighted has to be used instead. For
normal mode, the third argument can be omitted.

8.1.3 Logarithm

The logarithm command takes the logarithm log(y) (to the basis e) of the value y of each
channel in the math range.

Warning: Taking the logarithm of a nonpositive number produces no
error. Instead, the value is set to zero. This causes a spectrum that was
”continuous” before to become uncontinuous in the logarithmic graph
since the difference between log(0.001) = −6.91 and log(−0.001) = 0 is
much larger then it was before. Please ensure that your spectrum has no
negative values to avoid this.

JScript Syntax: Taking the logarithm of the current spectrum is done by:

SpecMath.Log(Specbar.CurrentSpectrum);

8.1.4 Exponential

The exponential command takes the exponential exp(y) of the value y of each channel in
the math range.
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JScript Syntax: Taking the exponential of the current spectrum is done
by:

SpecMath.Exp(Specbar.CurrentSpectrum);

8.1.5 Shift and Squeeze

Shift and Squeeze are sometimes used to calibrate a measured spectrum. The usual way
to do this is to use the Calibration Assistant which determines a channel-to-wavelength
polynomial. But sometimes only a certain range shall be modified. The commands work
on channel basis, not on wavelength basis. In fit routines, shift and squeeze parameters
also play a great role, since reference spectra might differ slightly in their scaling from the
measurement spectrum.

The shift command shifts the spectrum to the left for postivie values and to the right for
negative values. The spectrum is shifted as many channels as is entered in the dialog box.
You can enter decimal numbers, but in the end only are rounded to integers.

The sqeeze command squeezes a region into the math region, i.e. for a squeeze number s > 1
the range which is s times wider than the math region is mapped into the math region by
dividing the channel numbers by s. The fix point of the squeeze operation is the lowest
channel of the math range (left border). For values s < 1 the range is actually not squeezed,
but stretched. s = 1 is the identity.
In a shift and squeeeze, a range (partially) outside the math range is shifted/squeezed into
the math range. The math range is not shifted/stretched in a region (partially) outside the
math range. Therefore, only values within the math range will be altered.

Warning: If the region that shall be mapped into the math range is outside
the full range of the spectrum (for example if the whole spectrum is marked
and shall be squeezed), the range within the math range for which no
values are available are all set to the value the lowest/highest channel (the
right/left border of the spectrum).

JScript Syntax: Shift and Squeeze can be done by:

SpecMath.ShiftAndSqueeze(Specbar.CurrentSpectrum, fShift,
fSqueze);

where fShift and fSqueeze are float variables or numbers. Alterna-
tively, there are seperate commands for both shift and squeeze:

SpecMath.Shift(Specbar.CurrentSpectrum, fShift);
SpecMath.Squeeze(Specbar.CurrentSpectrum, fSqueze);
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8.1.6 Invert

The invert command takes the negative −y of the value y of each channel in the math range.

JScript Syntax: Inverting the spectrum is done by:

SpecMath.Invert(Specbar.CurrentSpectrum);

8.1.7 Reciprocal

The reciprocal command takes the reciprocal 1/y) of the value y of each channel in the math
range.

Warning: Division by zero causes no error, but sets the value to zero.
Unfortuntaely this causes incontinuities in spectra that have zero points.
So be aware of this fact!

JScript Syntax: Taking the reciprocal of the current spectrum is done by:

SpecMath.Reciprocal(Specbar.CurrentSpectrum);

8.1.8 Reverse

The reverse command reverses the order of channels within the math range, i.e. the first
channel in the range becomes the last (and vice versa), the second becomes next to last and
so forth.

JScript Syntax: Taking the reverse of the current spectrum is done by:

SpecMath.Reverse(Specbar.CurrentSpectrum)

8.1.9 Zero Out

This command sets all those values of the channels within a marked range to zero, which
absolute value is below the value that is specified in the dialog box.

JScript Syntax: Doing Zero Out of the current spectrum for all values
below 10 is done by:

SpecMath.Zero(Specbar.CurrentSpectrum,10);
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8.1.10 Normalize Amplitude

This command muliplies the values of a spectrum by an overall constant so that the am-
plitude of the spectrum is normalized, that is in such a way that the maximal value of the
spectrum is set to a normalization value that is specified in a dialog box.

JScript Syntax: Normalizing the current spectrum to 1 is done by:
SpecMath.NormalizeAmplitude(Specbar.CurrentSpectrum,1);

8.1.11 Normalize Energy

This command normalizes the area under the graph of the spectrum in the active spectrum
sheet to the value that is entered in the dialog box. This is especially useful if you want to
convolute as the convolution is not supposed to affect the order of magnitude of the spectral
values. Considering this it is necessary to normalize the convolution core. In other words
its area has to be one. Through this you can for example take the spectral line of a mercury
lamp as a convolution core, normalize the surface area by using ”normalize energy” to one
and then convolute the line.

The algorithm works as follows: All values of the channels within the math range are summed
up and one obtains the area (energy) Ebefore (”‘discrete integration”’). Then the spectrum
is multiplied by the ratio Eset/Ebefore, where Eset is the Energy specified in the dialog box.

JScript Syntax: Normalizing the area under the graph of the current
spectrum to 1 is done by:

SpecMath.NormalizeEnergy(Specbar.CurrentSpectrum,1);

8.1.12 Bias Adjust

This command just subtracts the average of the values of the spectrum from the values
within the math range.

Warning: The average of the spectrum is not calculated in respect to the
math range, but the overall spectrum.

JScript Syntax: Adjusting the bias to the average of the values of the
current spectrum is done by:

SpecMath.BiasAdjust(Specbar.CurrentSpectrum);

8.1.13 Ring spectrum

This command shall be used for spectra which were recorded by using sun light. In this
case, the so called ring effect has to be corrected. The ring effect is due to the Frauenhofer
lines in the sunlight.
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JScript Syntax: The ring spectrum is calculated using

Scattering.CalcRingSpectrum(Specbar.CurrentSpectrum);

with the following default values: Temperature: 250K, JMax: 30, Mixing:
0.8, SZA: 90. One can of course specify these values:

CalcRingSpectrum(specOrig, 250, 30, 0.8, 90);

Warning: The ring spectrum can of course only be calculated if the
spectrum has wavelength information.

8.1.14 Dark Current and Offset

Dark current and offset corrections are important to reduce the error that is due to CCD
imperfections. Dark current effects arise for example because of the finite temperature of
the chip (thermal excitations of channels occure), offset effects arise because of readout im-
perfections. Therefore, before and after a series of measurements, a dark current spectrum
(one scan with high exposure time) and a offset spectrum (high number of scans and very
short exposure time) should be recorded.

The Correct Dark Current command subtracts the dark current spectrum from the spectrum
to which it is applied in the so called time-weighted mode; compare spectrum operations

The Correct Offset command subtracts the dark current spectrum from the spectrum to
which it is applied in the so called scan-weighted mode; compare spectrum operations

8.1.15 Convolute

The Convolute command convolutes a cross section spectrum with the instrumental function
that has to be specified in a dialog box.
A convolution (german: Faltung) is smearing out a given spectrum, using the so-called
kernel, which usually is the instrumental slit function. For example, a theoretical calculation
of a spectrum (or a spectrum recorded under ideal conditions, with a delta function as the
slit function) is convoluted to compare it with the measured spectrum.
Convolution can be done both on wavelength or channel-basis.
The kernel is defined by the math range of a spectrum. The center of the kernel function
and therewith the origin of the convolution kernel is the center of the math range A cubic
spline is used to get a continuous function of the kernel.

JScript Syntax: Convolution is done by using:

SpecMath.Convolute(ISpectrum specSource, ISpectrum specKernel,
ISpectrum specTarget, ConvolutionKernelMode ckmKernelMode);

where ConvolutionKernelMode is either ConvolutionKernelMode.Normal
or ConvolutionKernelMode.Normalize, where the second mode is used
when the kernel shall be normalized before convolution.
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8.2 Navigate an Open Spectrum

8.2.1 Move and Zoom

By default, a spectrum will be displayed in the entire range, e.g. 1024 channels (exception:
spectrums in the Fit Result window, which are displayed in the fitting range).
You can zoom into the spectrum by drawing a box of a width corresponding to the range
that shall be displayed. By clicking the right mouse button, you zoom out to the entire
range again.

Hint: You can shift the range that is displayed by one channel by pressing
the left or right key. You can shift it by 10 channels by pressing page up
or page down.

8.2.2 Markers

There are four types of markers:

• The marker consists of It is useful to display the value of a certain channel (which is
displayed when moved) or for acquiring coordinates (e.g. in the calibration assistant).

• The math markers (for determining a math range)

• The fit markers (for determinig a fit range)

• The optical density marker (for determining a range to calculate the optical density)

All markers are moved by dragging and dropping it in the lower part of the spectrum. They
can also be moved channelwise by pressing Strg-left or Strg-right. If more than one
marker is visible, this is applied to the marker that was moved last.
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